
 Meeting Announcement
 

 
 
 

 

WEDNESDAY, MARCH 8, 2006 
 

Meeting Location 
Aims College Center 

Room 729 
Greeley, CO  80634 

 
Social / Networking---------------------------------------------- 5:30 PM 
Program ------------------------------------------------------------ 6:00 PM 
Business Meeting ------------------------------------------------ 7:00 PM 
 

  
 

 
 
 

 

 

Leap Into Action – Enhance Your Life 
“If the Shoe Fits”  

 

Mark Florio 
Florio’s Shoes 

 
Mark Florio will enlighten us with shoe history and fitting techniques.   

Come learn how to keep those tootsies happy!! 
 

Please contact Elaine for more information  
RSVP APPRECIATED!   
Hope to see you there! 

 

Elaine Furister CPS/CAP 
970.352.9413 

efurister@comcast.net 
 

 

Remember: Guests are very important to us.   
Please RSVP by Wednesday, March 1, 2006 
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LEAP INTO ACTION! 
Esther Camacho 
2005/2006 Chapter President 
 

Without action, dreams are but 
illusions.  Leap into action and make 

your dreams come true! 
 
 
Hello Ladies!  
 
I hope you are all enjoying the 
beautiful snow, looks like winter 
finally came in!  Nothing like the 
weather we had on the night we 
had our speaker. Speaking of, did 
you all enjoy learning about your 
personality? I was surprised to see 
the few number of caregivers and 
socializers we had. Nevertheless, 
I'm sure we all learned good tips on 
how to "negotiate" with each 
different personality.  
 
I would like to take this opportunity 
to encourage each and every one 
of you to bring more guests to our 
meetings. I know when I first was 
becoming familiar with this 
wonderful group, the special 
speakers we had made a true 
impact. Keep doing such a 
wonderful job, and I'll see you all 
next meeting! 
 
Regards, 
Esther 

 

 

 

 

INFORMATION EVERYWHERE. .  .POSITIVE INFLUENCE 
 
 

ome of the best process-improving, money-saving and career-
advancing ideas come from employees who have the moxie to speak 
up! (And executives know this.) When these employees see a 

problem they can solve, they’re unwilling to sit on the sidelines: They’d 
rather take that ball and run with it, dodging obstacles and weaving around 
a naysayer or two so they can get a touchdown that benefits the entire team. 
 
But exactly how can you influence executive decisions and make an even 
greater impact on your workplace? These ideas can help: 
 
• Do your homework. Before approaching leaders with any idea or 

viewpoint, get all the facts that support your proposal. Be prepared: 
Plan who you’ll approach and how to share your message so you’re 
most persuasive and effective. Remember, just because you have a 
rock-solid idea doesn’t mean you won’t have to sell it. Doing your 
homework in advance is your best bet. 

 
• Take the initiative. Next, have the courage of your convictions to step 

forward. An idea worth pursuing is an idea worth fighting for. Explore 
all the angles, long before you’re asked to. Have answers to possible 
questions ready. Think like an executive – which means, think ahead 
and act with purpose. 

 
• Volunteer to assist with related work. One great way to influence 

executive decisions is to volunteer to assist a project or process. Extra 
hands, and minds, are often in demand. Asking to join related 
committees and teams is a good way to get involved. 

 
• Be persistent. Finally, recognize that your efforts may not pan out in 

the beginning. Don’t give up! It may take approaching the same 
problem and the same people several times before your brilliant 
viewpoint is acknowledged. This is common, so try not to take it 
personally. Keep plugging away, and you’ll eventually win the day.  

 
Use any or all of these ideas, and you’ll be a “Star Performer” who truly 
makes a difference! ♣ 
 

©Office Dynamics, Ltd., 2006 

S
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UNION COLONY CHAPTER 

Website: 
www.orgsites.com/co/iaapucc 

MISSION 
Union Colony Chapter is 
committed to: 
• Educational Programs 
• Leadership Enrichment 
• Professional Development 

 
 

2005-2006 OFFICERS 
 

Esther Camacho   
  President --------- 970.406.4140 
Elaine Furister CPS/CAP, Vice 
President ---------- 970.352.9413 

Sheri Garland, Secretary 
------------------------- 970.506.7618 
Cathy Witte CPS, Treasurer 
------------------------- 970.350.9794 
 

 

MINI TASK GROUPS 
 

APW Event 
----------- Nancy Upchurch CPS/CAP 
-------------------Sue Young CPS/CAP 
 
Bylaws & Standing Rules 
------------------------- Cathy Witte CPS 
----------- Nancy Upchurch CPS/CAP 
 
Education 
-------------- Elaine Furister CPS/CAP 
--------------------------Beth Gibbs CPS 
 
Installation/Membership 
-------------------Barbara Swetzig CPS 
------------------------------Ellen Hetterle 
 
Newsletter 
----------------------Trudy J. Miller CAP 
-------------------- Vi McNew CPS/PRP 
 
Nominations 
----------------------------------------- TBD 
 
Program, Publicity, Historian 
-------------- Elaine Furister CPS/CAP 
------------------------------- Ginger Zech 
 
Scholarship 
-------------------Sue Young CPS/CAP 
-------------------Barbara Swetzig CPS 
 
Ways & Means 
------------------------- Cathy Witte CPS  
 

 

BOARD MEETINGS 
All UCC members are invited 
and encouraged to attend the 
board meetings.  

MICROSOFT EXCEL: CONDITIONAL FORMATTING 
f you have ever manually formatted Excel cells to highlight important data, then 
you need conditional formatting. If you want an automatic way to easily display key 
values and results, then you need conditional formatting. 

 
Conditional formatting in Microsoft Excel allows you to set rules for automatic cell 
formatting. If the rules (conditions) are met, then the formatting is applied. You can 
have up to 3 criteria in a cell. 

 
Conditional Formatting and Analysis 

To view or create conditional formatting, 1) Select cells, 2) Format > Conditional Formatting,  
3) Set criteria, 4) Choose format 

Training Classes 

Employee 
Name Class Class Date* 

Renewal or 
Exp 

Days 
Due 

60 Days or 
Less for New 

Training 
Billy Bob CPR 4/25/2005 4/25/2006 65 OK 
Mary Jo Heavy Equipment 

Safety 
1/15/2005 1/15/2006 -35 Training 

Needed 
Suzi Q Diversity in the 

Workplace 
4/3/2005 4/3/2006 43 Training 

Needed 
Big Jim Sensitivity Workshop 9/22/2005 9/22/2006 215 OK 
Daisy 
Mae 

Scaffold Training 3/15/2005 3/15/2006 24 Training 
Needed 

 * formula added to Class Date to maintain example relevance  
      
      
 
 
 
 
 
 
 

How to Apply Conditional Formatting  

1. Select the cells to be formatted. 
2. Choose Format > Conditional Formatting... 
3. Leave the first drop-down box set to Cell Value Is (the other option is 

Formula Is which requires formula criteria. 
4. In the second drop-down box, choose one of the operators such as 'greater 

than or equal to' or 'between'. 
5. In the text box, type a number or a cell reference. For instance, you may want 

to format all cells with a value greater than the value in cell B5. 
6. Click the Format button. 
7. Choose any combination of Font, Border and/or Patterns. 
8. Click OK. 
9. To add another conditional format, click the Add button. 

Conditional Formatting Continued on Page 3 

I 

Formula:  
=IF(E7>60,"OK","Training 
Needed") 
 
Conditional Formatting: 
Formula Is 
=-(TODAY()-D7)<=60 
Display in blue, bold and italic 
if formula result is true  

Formula:  
=-(TODAY()-D9) 
 
Conditional Formatting: 
Cell Is 
Display in bold blue text if cell 
value is between 60 and 30. 
 
Display in bold white text on a 
red background if cell value is 
less than 30.  
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NEWSLETTER CONTRIBUTIONS 
All committee reports are due at the 
monthly chapter meeting.  All other 
submissions are due to Trudy Miller 
(tjmiller@henselphelps.com) no later 
than the 18th of each month. 
 

SUNSHINE FUND 
Our “Sunshine Fund” is designated 
for events such as births, 
congratulations, deaths, etc. that 
cannot be funded with IAAP monies.  
Members may donate $1 to place 
their names in a door prize drawing.  
The winner is then responsible for 
bringing the door prize the following 
month.  (Door prize values can range 
from $5-$10.) 
 

ANNIVERSARY/BIRTHDAY 
 A B 
February 
Mona Boyd CAP ---------- 1998 ----8/25 
Sheri Garland -------------- 2003 ----3/19 
Trudy J. Miller CAP------- 1998 ----- 3/3 
Stephanie Vallejo --------- 2002 ----5/14 
March 
Tammy L. Fiscus---------- 2005 ----2/24 
Beth Gibbs CPS---------- 1990* ----4/30 
Ellen Hetterle--------------- 2003 ----2/24 
Barbara Swetzig CPS -- 1990* ----- 9/4 
Nancy Upchurch CPS/CAP1990* ---3/23 
Ginger Zech ---------------- 2004 ----12/7 
April 
Michelle Barraclough ---- 2005 ----- 3/9 
Dorothy Brethauer -------- 2001 ----- 5/5 
Diana Gross---------------- 2004 ----9/22 
May 
Esther Camacho ---------- 2004 -- 11/19 
July 
Ann Grotness -------------- 2005 ----11/6  
Mary Lenhart --------------- 1997 ----8/21 
Tobi Vegter ----------------- 2005 -- 11/21 
August 
Cathy Witte CPS ---------- 1996 ----7/28 
October 
Betty Carwin CPS--------- 2000 ----- 3/4 
Harriett Meeker------------ 2005 
November 
Sharon Lynch --------------11/05 
Sue Young CPS/CAP---- 1994 ----5/22 
December 
Elaine Furister CPS/CAP- 2000 ----- 3/3 
Rosalinda Rodriguez----- 2005 ----6/26 
Becky Sperber CAP------ 1995 ----- 5/8 
 

* Charter Member 
 

IAAP SPONSORS 
www.officeteam.com 
www.mmm.com/office 
www.avery.com 

CONDITIONAL FORMATTING (cont.) 
10. Repeat steps 3 to 8, choosing the criteria and format for the second condition. 

A third condition is also allowed. 
11. Click OK to return to the worksheet and apply the formatting 

 

Change or Remove Conditional Formatting 

1. Select the cells with the format that you want to change or delete. 
2. Choose Format > Conditional Formatting... 
3. To change, select Format for the condition you want to modify. To start from 

scratch, pick the Clear option and then pick your formatting choices. 
4. To remove conditional formatting, choose Delete and check which conditions 

you want to delete. 
5. Choose OK twice to apply the changes. 
 

Find Cells That Have Conditional Formatting 

1. To find all cells that have conditional formatting, click any cell. To find cells 
that have conditional formatting settings identical to the settings of a specific 
cell, click the specific cell. 

2. Pick Edit > Go To.  
3. Click Special.  
4. Click Conditional formats.  
5. Do one of the following: 

To find cells with any conditional formatting, click All below Data validation. 
To find cells with identical conditional formats, click Same below Data 
validation. 

6. OK to return to the worksheet; cells with conditional formatting will be 
selected.♣ 

SoftwarePro.com 

 
 

BILL ME LATER? 
f you’re among the one-third of all web users who refuse to use credit 
cards when making purchases online, there’s a new service coming your 
way called Bill Me Later. Online giants WalMart.com, Priceline.com and 

eToys.com have been trying out this new payment option that’s tailored to 
coax web-wary consumers over to the electronic side. Here’s how it works: 
 
Select your purchase (at a site that offers Bill Me Later)  
Pay for your purchase by entering a minimum amount of information about 
yourself (date of birth and the last four digits of your Social Security 
number)  
Pay for the item after you receive your bill in the mail 
 
Bill Me Later is a payment system created by Maryland-based I-4 
Commerce, Inc. Millions of consumers have used the service, and some 
230 major online retailers currently offer it. If you’re interested in checking 
out the company’s stock, you’ll have to wait. The company is currently 
privately held, although analysts anticipate a public offering in 2007 
(source: BusinessWeek). ♣ 

 
WomensWallstreet.com 

 

I 
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CWM DIVISION 
Website: 
www.orgsites.com/co/cwmiaap 
 
2005-2006 OFFICERS 
Sharon Hunvald CPS, Denver 
President ------------------- 719.597.9157 
Cory Scarbrough CPSCAP, Denver 
Downtown 
President-elect------------ 303.870.8344 
Chris Church, Book Cliff 
Vice President ------------ 970.243.5219 
Margaret Hartl, Rim Rock 
Secretary------------------- 406.657.2367 
Glenda Brown CPS/CAP, Rim Rock 
Treasurer------------------- 307.587.8108 
Juanita Cosslett CPS, Book Cliff 
Parliamentarian----------- 970.245.1734 
 
CWM DIVISION COMMITTEES 
Annual Meeting ---------Deb Brown CAP/RP 
----------------------------------Linda Wolfe CPS 
Bylaws & Standing Rules 
------------------------Jackie Clough CPS/CAP 
Certification ----------- Jalane Glasgow CAP 
Membership ---------------------- Chris Church 
New Chapter Builder Juanita Cosslett CPS 
Newsletter / Website Review 
--------------------Cory Scarbrough CPS/CAP 
Nominating -----------------------------------TBD 
Retirement Trust Foundation 
 ------------------------------JoAnn Dayton CPS 
Ways & Means  
-----------------------------------------Linda Street 
  

AROUND THE DIVISION 
Colorado Chapters 
Book Cliff -------------Kyle Sheldon-Chandler  
Boulder-----------------------Stacia Keller CPS 
Denver --------------------- Andrea Latine CPS 
Denver Downtown* --------------Annette Piltz 
HP Northern Colorado ---Marie Buquo CPS 
IBMC White Eagles Student--- Tara Dubois  
Mountain View ---------------Rolene Cogburn  
Pikes Peak--------------Marilyn Sullivan CPS 
Pueblo Kachina** ---------Joyce Bergemann 
Union Colony---------------- Esther Camacho 
Wyoming Chapters 
Old West--------------- Karen Schroeder CPS 
Western Horizons ------------Corina Draycott 
Montana Chapters 
Rim Rock -------- Darlene Chamberlain CAP 
 
* Breakfast Meeting 
** Lunch Meeting 

 
“Better to be occasionally 
cheated than perpetually 

suspicious.”  
-- B.C. Forbes 

NEED A THEME FOR YOUR NEXT BUSINESS MEETING? 
 

heck out this new-for-2006 "Theme Ideas Handbook," which 
contains more than 600 theme ideas, as well as "how to" information 
and worksheets. It's available for immediate download and use for 

any meeting, conference, event, or occasion.  
  
It was designed to overcome the problems and headaches of staff 
limitations, tight deadlines, limited budgets, and creative dry spells when it 
comes to creating themes. 
  
Here's a small sample of the themes you'll find: 
 

• T.E.A.M. = Together Everyone Achieves More  

• Teamwork in Action  

• Brown Bag Briefing  

• “Tell Someone They’re Doing a Great Job” Day  

• They Said It Couldn’t Be Done  

• Delight the Customer  

• T.O.P.S. – Total Organization Promoting Service  

• Treating Customers Right  

• Triple Threat 
To get the "Theme Ideas Handbook," visit 
http://www.bizmotivation.com/themes.htm. 

 
HAPPY ST. PATRICK’S DAY!! 

 
 

WORD LEARNING 
abulia \ay-BOO-lee-uh\ noun: abnormal lack of ability to act or to make 
decisions  

Example sentence:  
"Since his college graduation, my son seems to be suffering from abulia — 
he just can't decide what he wants to do next," sighed Philip.  

C
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2005-2006 INTERNATIONAL 
BOARD OF DIRECTORS 
 

President Kay E. Enlow CPS/CAP; 
President-Elect Sandra P. Chandler CPS; 
Vice President Judy McCoy CPS/CAP; 
Secretary Barb Horton CAP; Treasurer 
Susan K. Shamali CPS/CAP; Affiliate 
Representative Leanne Fisher AOP JP; 
Great Lakes District Director Mary A. 
Ramsay-Drow CPS/CAP; Northeast 
District Director Linda M. Lorden CPS; 
Northwest District Director Lynda B. 
Boulay CPS/CAP; Southeast District 
Director Tia Theriaque CAP; Southwest 
District Director Patti S. Speer; Canada 
District Director Kathryne Hampton 
CPS/CAP. 
 
2005-2006 INTERNATIONAL 
RETIREMENT TRUST 
FOUNDATION TRUSTEES 
 

 

(from left) C. Joyce Hawkins CPS/CAP, 
RTFC Liaison; Myrna Jessell CPS/CAP, 
Chairman; Linda M. Cook CPS/CAP, 
Secretary; Janine Riemersma CPS/CAP, 
Vice President; Kay E. Enlow CPS/CAP, 
International President; Susan K. Shamali 
CPS/CAP, International Treasurer 

 
2005-2006 COLORADO-
WYOMING-MONTANA DIVISION 
BOARD OF DIRECTORS 

 
(from left) Glenda Brown CPS/CAP, 
Treasurer; Margaret Hartl, Secretary; Chris 
Church, Vice President; Cory Scarbrough 
CPS/CAP, President-elect; Sharon 
Hunvald CPS, President 

PARLIAMENTARY LEAPS:  PROTOCOL 
– Vi McNew CPS/PRP 

Boulder Chapter Member 
 

rotocol involves courtesy and consideration given to guests and honored members 
of our Association. 

 
In our IAAP Chapters, the matter of protocol is left up to the presiding officer or the 
program chairman. This involves seating guests, honored members, and/or past 
presidents, paying attention to their rank and seating them in the correct pecking order. 
If there are opening ceremonies involved, this could include arranging for a clergyman 
to present the invocation, a leader for the flag ceremony, music, and the like. 
 
In seating arrangements, the president is always in the center, the first ranking guest on 
the right of the president, the second ranking guest on the left of the president. This 
seating is continued until the head table (platform) is filled. 
 
When introducing guests, the highest ranking official is presented first; however, if the 
guests are expected to say a few words, begin with the lowest rank and continue up the 
scale with the highest rank last to give this person prominence and the opportunity to 
speak the longest. When presenting past presidents, always give the year of their 
administration. It is absolutely essential that each name be properly pronounced and 
should be rehearsed by the person making the introductions. 
 
Special or honored guests should be invited in advance and should be advised as to the 
place, hour at which they are to be presented, the length of time for their presentation 
and whether or not they will be expected to answer questions. It is well to contact a 
speaker a couple of days before the date of the meeting to make sure all details have 
been confirmed. These include transportation to and from the airport, hotel 
reservations, and payment of the fee/honorarium, if any. The person in charge of 
protocol (or a designated person) should meet the guest and introduce the guest to the 
president and other officers if they have not previously met. Honored guests should 
never stand in line for refreshments. The secretary of the organization should promptly 
send a "thank you" note on behalf of the organization. 
 
Each chapter has its own way of seating officers at meetings. It is this writer's opinion 
that it is much easier for the presiding officer to have the current officers (vice 
president, secretary, treasurer, parliamentarian) seated at a table facing the membership 
for the simple reason if the presiding officer needs to confer with one of these officers, 
it is less of an interruption to the assembly to have that officer near at hand. As noted 
above, the presiding officer is always in the center; a proven successful seating 
arrangement is for the secretary to be seated to the presiding officer's right and the 
parliamentarian to the presiding officer's left, with the vice president next to the 
secretary and the treasurer next to the parliamentarian. 
 
There is not, to my knowledge, any hard and fast rule about this and whatever is 
comfortable for the president (presiding officer) should be followed. If there is a guest 
speaker, this speaker should be seated, as noted above, to the right of the president. In 
larger meetings, such as a Division meeting, if a head table is used, it will require 
adjusting the officer seating to allow for the additional persons; many times this can be 
handled by having the vice president, secretary and treasurer seated in the assembly 
until the opening ceremonies have been accomplished. The clergy/city official are then 
given the opportunity to leave and the officers can then join the president for the 
commencement of the business meeting. 
 
The important thing to remember is to give the honored guests and visiting officials the 
proper recognition. This contributes to the esteem of the organization and is well worth 
the time and effort in seeing that rank is properly recognized.♣ 
 

P 
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IAAP EVENTS 
 

 

INTERNATIONAL CONVENTIONS 
 

August 7-10, 2006 
Reno Hilton  
Reno, NV 
 

July 29-August 1, 2007 
Tampa Convention Center 
Tampa, FL 
 

July 27-30, 2008 
Hilton New Orleans Riverside 
New Orleans, LA 
 

July 26-29, 2009 
Minneapolis Convention Center 
Minneapolis, MN 
 

July 18-21, 2010 
Hynes Convention Center 
Boston, MA 
 

July 18-21, 2010 
Hynes Convention Center 
Boston, MA 
 

July 24-27, 2011 
Montreal Palais de Congress 
Convention Center 
Montreal, Quebec 
 
CERTIFICATION SEMINAR 
October 16-19, 2005 
Hyatt Regency Chesapeake 
Bay – Cambridge, MD 
 

October 15-18, 2006 
Marriott Rancho Las Palmas 
Resort & Spa – Palm Springs, 
CA 
 
PROFESSIONAL EDUCATION 
CONFERENCE 
 

February 26-March 1, 2006 
Flamingo Hilton Hotel – Las 
Vegas, NV 
 

March 4-7, 2007 
Hyatt La Jolla – San Diego, CA 
 

TRAVEL LEAPS:  BAGGAGE TIPS 
 

he airlines have upgraded baggage tracking technology so reuniting 
passengers with luggage is much quicker and easier today. It's 
encouraging that only .005% of all checked baggage is permanently 

lost. Luckily, most bags will catch up with you within hours (usually the next 
flight on your route) and the airline will deliver it to you by courier. 
 
As a passenger, you can take certain precautions that can help the airlines 
return items you leave on a plane or get your bags back to you quickly 
should they temporarily go astray en route. 
1. It's important to remember that traveling has inherent risks. It's never 

prudent to pack (or in some cases, even take along) expensive items or 
belongings that are hard or impossible to replace. 

2. Any valuables you have should be kept with you as you travel including 
prescriptions, travel documents and cash, as well as jewelry. Upscale 
catalogs and retail travel stores offer numerous products to conceal 
valuables such as money belts. 

3. If the nature of your travel demands that you routinely take expensive 
jewelry and clothing or equipment, be sure you cover their replacement 
value under a policy you buy in addition to the automatic, limited 
coverage provided by the airline. Check with your own insurance 
company for this protection or buy excess valuation coverage on the 
spot at the ticket counter. 

4. Bag tags are required, but they can be torn off. Some suitcases have a 
slide-in window about the size of a business card for secondary 
identification. Consider these when shopping for a new suitcase. 

5. Some travelers put their identification on the bags tags when they 
purchase the luggage and never think about it again. Airlines 
sometimes discover the owner of the bag has not lived at the address 
on the tag for many years. Make sure yours are up to date. 

6. Put additional identification inside your bag including a copy of your 
itinerary. This can help the airlines know whether to send your bags to 
your travel destination or your home. 

7. With stricter conditions on carry-on baggage, you may find suitcases 
and hanging bags you previously were able to sneak on board will 
need to be checked. That's why it's smart to take precautions on every 
bag, even the ones you plan to keep with you on the plane. 

8. Put your name and address on everything. Remember camp? The 
reason your mom sewed labels in your underwear is the same reason 
you want to label things you don't think of as luggage - your glasses 
case with your expensive designer eyewear inside, your camera and 
camera bag or the extra tote you bought on the trip to carry all those 
goodies home. If you leave these items behind on the plane, it's 
essential that you have identification on these items so they can be 
found among the hundreds of similar items left in overhead bins or seat 
pockets. 

    Baggage Tips Continued on Page 8 

T
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IAAP Information 
 

UNION COLONY CHAPTER 
PO Box 336578 
Greeley CO  80633 
Website: 
www.orgsites.com/co/iaapucc 

 

NW DISTRICT DIRECTOR 
Lynda B. Boulay CPS/CAP 
1808 Windjammer Drive 
Woodbury MN 55125 
Work 651.739.6413 
Fax 651.501.3926 
Home 651.501.3923 
E-mail: lboulay3926@msn.com 
 
 

IAAP HEADQUARTERS 
PO Box 20404 
Kansas City MO  64195-0404 
----------------------- 816.891.6600 
-----------------Fax: 816.891.9118 

Web Site:------- www.iaap-hq.org 
 
 

Union Colony Chapter 
Upcoming Calendar 

 

Our Agenda 
Social/Networking------- 5:30 PM 
Program ------------------- 6:00 PM 
Business ------------------ 7:00 PM 
 

 

Aims College Center 
Room 729 

 

March 8, 2006 
“If the Shoe Fits” 

 

 
2006 CWM DIVISION 
ANNUAL MEETING 

 
June 2-3, 2006 

Radisson Graystone Castle 
Denver, Colorado 
1.800.333.3333 

E-MAIL MESSAGES 
 

erhaps the most frequently used form of business writing is the e-
mail. E-mails offer quick, immediate communication and feedback, 
encouraging better communication between employees and 

departments as well as improving connections between business and 
clients. However, there are some drawbacks to the medium. Whenever you 
start to write an e-mail, consider the following factors. 
 
Strong Points 

• E-mail is fast. Electronic messages travel swiftly, allowing for quick answers and 
turnaround.  

• E-mail is flexible. You can store received messages for later retrieval, embed links 
within your text, and easily communicate with people across the room or across the 
world.  

• E-mail is efficient. By using the “reply” feature, you can create an easy-to-read trail 
of messages, creating a record of a “conversation.”  

• E-mail is economical. There’s no expense for postage or paper—and no paper 
waste. 

 
Weak Points 

• E-mail has a reliability risk. E-mails have been known to disappear into the ether.  
A power failure could interrupt communication. If a recipient’s mailbox is full, the 
message could bounce.  

• E-mail lacks confidentiality. An e-mail message is about as private as a postcard. 
It could be forwarded without your knowledge or could even end up in the wrong 
mailbox!  

• E-mail could encourage laziness. Many look at e-mail as a casual form of 
communication and thus don’t bother to revise or edit their messages. Also, it’s too 
easy to send a message in haste—especially a response—which could lead to 
problems later on. 

For that reasons, e-mails are generally not recommended as a means of formal, professional 
communication. When the message is critical, you’ll do better to write it out and send it by 
ground mail. But for quick notes and immediately communication, you can’t beat e-mail! 

E-mail Hints 

Never fire off an angry e-mail response.  Let yourself cool off 
before responding. Never use abusive or insulting language—called 
“flaming.” 

Check your e-mail on a regular basis. Because of the immediacy of 
e-mail, it’s advisable to check three times a day: once in the morning, 
once around lunchtime, and once before you leave work. This will 
assure that you receive important messages in a timely fashion. 

Answer anything that requires a response. If you can’t respond 
immediately, send a quick note acknowledging receipt and explaining 
that you will respond completely at a later time. 

Don’t forward spam or jokes. Unless you know the recipient would 
want the material, resist the urge to send it to everyone on your 
mailing list. 

Use an automated response. Let correspondents know if you can't 
read e-mail for a while. 

Be selective. Send e-mails only to pertinent parties. Not every 
message needs to go to everyone in the office.♣ 

 
UpwritePress.com 

P
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May you always have walls 
for the winds, 

A roof for the rain, tea 
beside the fire, 

Laughter to cheer you, those 
you love near you, 

And all your heart might 
desire! 

 
An Irish Blessing 

 
"The more elaborate our 

means of 
communication,  

the less we 
communicate." 

Joseph Priestly 
 

 

FEBRUARY'S A GOOD MONTH TO . . . 

• Go through and organize last 
year’s tax records.  

• Establish and explain bonus 
opportunities for employees.  

• Ask for employee vacation 
dates for the year.  

• Examine project schedules for 
the year and revise if 
necessary.  

• Plan a social event for 
employees to offset the gloom 
of winter and reconnect on a 
personal level. 

BAGGAGE TIPS CONTINUED 
9. Before packing for any trip, check all the zippers and locks on your 

bags since they may have become worn or broken on a previous trip. 
And be aware, even if the zippers and locks are in good condition, 
overstuffed luggage is prone to burst open during the normal shuffle 
between the terminal and the plane. 

10. Make an inventory of the items packed in each bag to assist the airlines 
in finding your luggage. 

11. To prevent your look-alike bag from being grabbed off the carousel by 
a traveler too rushed to check the tags, tie a colored ribbon on the 
handle or secure a colored elastic band (made for this purpose) around 
your suitcase. These kinds of mix-ups are preventable, so take 
precautions. 

12. Tip the Skycap! It's smart to be especially courteous to the Skycap. A 
tip and a respectful attitude can go a long way to making a Skycap 
extra careful to get your bags checked carefully. 

13. Take the time to make sure the airline tag placed on your luggage 
correctly identifies the last destination on your journey. This can 
prevent your bag from being off-loaded too early or stopping in a city 
half-way to where you are going. If you don't know the three-letter ID 
for your city, ask the Skycap or ticket agent. 

14. Be sure you get your bag tag stubs with the UPC bar code. In today's 
new era of ticketless travel, it's easy to forget these. You probably will 
get a ticket jacket with the tags attached, but sometimes they're just 
stapled to whatever you have - a faxed itinerary, for example, These 
act as your receipt and are your proof your bag was checked. Treat 
them as important travel documents. 

15. On the plane, carefully note where you've stashed items. If the only 
overhead space that is available is over row 27 and you're in row 23, 
you might grab your jacket from the closest bin and leave other 
belongings stowed elsewhere. 

16. If your luggage does not arrive in the baggage claim area, find the 
baggage agent on duty immediately. There's a chance your luggage 
already arrived and is locked up in the agent's area for safe keeping. 
Sometimes luggage is loaded onto a non-stop flight even though you 
were on a plane that had a stopover on the way so your suitcases get 
there before you. 

17. But if your luggage is not there, do not leave the airport before 
completing the paperwork for the baggage agent. Fill out all information 
about your luggage on the forms provided. Be as detailed as possible. 
Get a phone number to call in case you need to follow-up.  If you need 
basic amenities such as toothbrush, toothpaste and razor to be ready 
for a meeting, ask. Most airlines will provide these for you while you're 
waiting for your suitcase. 

If you follow these basic, common sense tips, you should reduce the risk of 
losing your luggage and precious belongings. 
 

     Lost Treasures Around the World
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UNION COLONY CHAPTER IAAP CALENDAR OF EVENTS 

Date Event 
2006 
February 26-March 1 Spring Professional Education Conference 
March 8 If the Shoe Fits with Mark Florio from Florio’s Shoes – Chapter Meeting 
April 12 Website Development by Agtown Technologies – Chapter Meeting 
April  23-29 / April 26 Administrative Professionals Week® / Day® 

April 26 APC Event:  Together We Can…Creating Excellence in the Workplace – Colorado Convention 
Center (Hosted by City & County of Denver and IAAP) 

May 5-6 CAP and CPS Exams 
May 10 Dare to Dream, Bill Williams – Annual Meeting / Installation of Officers - Chapter Anniversary 
June 14 Leap Into Action for 2006/2007 - Brainstorming - Chapter Meeting 
August 7-10 IAAP International Convention and Education Forum  
 
IAAP ANNUAL CONVENTION & EDUCATION FORUM FUTURE DATES/SITES 

2006 August 7-10 Reno Hilton Reno, Nevada 
2007 July 29-August 1 Tampa Convention Center Tampa, Florida 
2008 July 27-30 Hilton New Orleans Riverside New Orleans, Louisiana 
2009 July 26-29 Minneapolis Convention Center Minneapolis, Minnesota 
2010 July 18-21 Hynes Convention Center Boston, Massachusetts 
2011 July 24-27 Montreal Palais de Congress Convention Center Montreal, Canada 
 
SPRING PROFESSIONAL EDUCATION CONFERENCE FUTURE DATES/SITES 

2006 February 26-March 1 Flamingo Hilton Hotel Las Vegas, Nevada 
2007 March 4-7 Hyatt La Jolla  San Diego, California 
 
IAAP CERTIFICATION SEMINAR (FOR CPS AND CAP HOLDERS AND APPROVED CANDIDATES) DATES/SITES  

2006 October 15-18 Marriott Rancho Las Palmas Resort & Spa Palm Springs, California 
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INTERNATIONAL ASSOCIATION OF ADMINISTRATIVE PROFESSIONALS 
COLORADO WYOMING MONTANA DIVISION CHAPTERS 

 
 
 

Chapter Name By City 
Chapter ID # 

Monthly Meeting & Time Chapter President Email 

Boulder Chapter  
- #321110 
Boulder, CO 

3rd Thursday  of the Month* 
Meeting – 6:00 pm 

Patti Lovato, Vice President 
plovato@ball.com  

Denver Chapter - #321140 
Denver, CO 

2nd Tuesday of the Month* 
Meeting 6:00 pm 

Andrea Latine CPS 
andrea.latine@analex.com 

Denver Downtown Chapter  
- # 321150 
Denver, CO 

2nd Wednesday  of the Month* 
Meeting - 7:30 am – 8:30 am 

Annette Piltz 
apiltz@pcisys.net 

Pikes Peak Chapter - #321130 
Colorado Springs, CO 

2nd Tuesday of the Month* 
Meeting - 6:00 pm 

Marilyn Sullivan CPS 
marilyn.sullivan@memhospcs.org 

HP Northern Colorado Chapter - 
#321153 
Fort Collins, CO 

3rd Thursday of the Month 
Meeting – 2:00 pm – 3:00 pm 

Marie Buquo 
marie.buquo@hp.com 

IBMC White Eagles Student Chapter 
- #93857470 
Fort Collins, CO 

Tuesday, October 18th at 5:00 pm 
Tuesday, November 15th at 12:00 pm 
Tuesday, December 13th at 5:00 pm 

Tara DuBois 
tdubois@ibmc.edu 

Mountain View Chapter - #321160 
Fort Collins, CO 

2nd Monday of the Month* 
Meeting - 6:00 pm 

Rolene Cogburn 
rolene_cogburn@msn.com 

Book Cliff Chapter - #321170 
Grand Junction, CO 

3rdWednesday of the Month* 
Meeting - 6:00 pm 

Kyle Sheldon-Chandler 
kyle@virtualadminksc.com 

Union Colony Chapter - #321100 
Greeley, CO 

2nd Wednesday of the Month 
Meeting - 6:00 pm 

Esther Camacho 
ecamacho@greeleytribune.com 

Kachina Chapter  - #321200 
Pueblo, CO 

3rd Tuesday  of the Month* 
Meeting – 12:00 Noon 

Joyce Bergemann 
joyce_bergemann@prbd.com 

Rim Rock Chapter - #325110 
Billings, MT 

3rd Wednesday of the Month* 
Meeting - 6:00 pm 

Darlene Chamberlain CAP 
dchamberlain@wyoben.com 

Old West Chapter - #332110 
Cheyenne, WY 

3rd Thursday of the Month*  
Meeting - 6:00 pm 

Karen Schroeder CPS 
klikoffice@bresnan.net 

Western Horizons Chapter  
- #332125  
Rock Springs, WY 

3rd Wednesday of the Month* 
Meeting - 6:00 pm 

Cory Draycott 
cdraycott@cityofgreenriver.org 

 
*Meetings in May are Closed to Members Only Due to the Election of Officers. 
  
 
 



3rd Annual  
Administrative Professional Conference 

 
 

Wednesday, April 26th 
Colorado Convention Center 

 

 
 

 

 
 

 
 
 
 
 
 

 
 

 
 

 
 
 
 
 
 
 
 
 
 

The 2006 Administrative Professional 
Conference is designed, planned and 
co-hosted collaboratively by chapter 

members of the International 
Association of Administrative 

Professionals® (IAAP®) and employees 
of the City and County of Denver  

Attention IAAP® Chapter Members: 
 
Have you decided how your organization can recognize and reward you on 
Administrative Professionals Day? 
 
Register today to participate in the 3rd Annual Administrative Professional 
Conference, Wednesday, April 26, 2006 at the Colorado Convention Center.  This 
conference is the event of the year for Administrative Professionals who are 
interested in learning how to increase their value with professional certification 
through the International Association of Administrative Professionals® (IAAP®), 
develop better working relationships, communicate with impact, lead people, 
manage and adapt to change, manage time effectively, and liven-up, loosen-up 
and release their enthusiasm and creativity.  
   

Conference Registration Fee: 
 

Early Bird Registration – by 5:00 p.m. , March 24th 
IAAP® Chapter Member - $99 

Non-City employee - $129 
 

Registration Fee – after 5:00 p.m., March 24th 
IAAP® Chapter Member - $149 

Non-City employee - $169 
 
The conference fee includes attendance at all activities and workshop sessions, as well as 
a continental breakfast and a sit-down lunch.  Registration is complete and valid upon 

receipt of registration form and payment. A check or money order is required  
to confirm registration. 

Date and Time: April 26th, 2006, 8:30 a.m. – 5:00 p.m. 
Location:  Colorado Convention Center 

2006 Conference Theme:  Creating Excellence in the Workplace 
 

Keynote Speakers: Stephen Covey, on Leadership; Jackie Frieberg on Becoming a 
Remarkably Different Administrative Professional; Kay K. Enlow, CPS/CAP – IAAP on The 

State of The Profession; Dr. Joseph Michelli on Life After Stress:  Finding Joy In Insane 
Times; and Sandra P. Chandler, CPS/CAP – IAAP on Turning Jobs Into Careers - 

Creatively  
 

Workshop Topics Include:  Professional Certification; Is Your Career in Balance?; Grace 
Under Pressure: Maintaining Your Cool When Things Get Really Hot; Who Do You Trust?; 
We’ve Got To Stop Meeting Like This!; Business Etiquette for the Business Professional; 
Did You Hear What I Said?; 2020:  Office of the Future; Change and the Administrative 
Professional – You’ve Got To Be Kidding!; Stress and Humor; Managing Your Personal 

Finances; Customer Service; and Manager’s Roundtable  
 

Special Appearance:  Adele Arakawa, 9KUSA News Anchor will moderate  
a live panel discussion between Administrative Professionals and 

 employers from both the public and private sectors 
 

  

 

Featuring via live satellite 
broadcast, Stephen  R. 
Covey, author of The 7 
Habits of Highly Effective 
People  

 

Kay E. Enlow, CPS/CAP, 
International President of 
IAAP® will present The 
State of The Profession 

For additional information 
or to register: 

 
Visit the website at:  

www.denvergov.org/adminprofessional 
 

Call:   720-913-5693 
  

 or e-mail: 
Destiny.Lee@ci.denver.co.us 

Dr. Joseph Michelli, 
Psychologist and 
International Speaker on 
Humor and Stress in the 
Workplace 

Skillbuilding session with Jackie 
Frieberg, author of Nuts! 
Southwest Airlines’ Crazy Recipe 
for Business and Personal 
Success 

Sandra P. Chandler CPS, 
International President-elect of 
IAAP®, Keynote speaker on 
Turning Jobs Into Careers - 
Creatively 

www.denvergov.org/adminprofessionals 


